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English Department

Writing Guide
WRITING GOOD PROSE, prose that is clear, subtle, and energetic – whether for
intellectual, creative, or journalistic purposes – is difficult. It is a skill acquired by
much practice and care. This guide helps you in two respects. It deals (a) with
issues of grammar, syntax, and punctuation, and (b) with what is called ‘style’, i.e.
the conventions of professional writing and referencing. Your lecturers will advise
you on these matters on a module-by-module basis, so don’t feel you need to
know all this straight away. Gradually, however, do assimilate more of this
material. To be a professional-level writer is a great skill for the workplace in a
wide range of fields. Few write good prose: it is a skill, habitus, or ‘craft’ (as
Richard Sennett would say).
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1 RECOMMENDED WORKS
1.1

GRAMMAR, SYNTAX, PUNCTUATION

For grammar, syntax, and punctuation, we recommend the following books or
websites (the books are in the library):
Improve Your Writing – Grammar Exercises – University of Bristol at

http://www.bristol.ac.uk/arts/exercises/grammar/grammar_tutorial/index.htm
Section G. ‘Exercises’ is particularly good: try its quizzes on the colon, semicolon, and
the comma splice.
Diane Collinson, et al, Plain English (2nd edition, Open UP, 1992). Chapter 2 is
particularly good for issues of punctuation.
William Strunk and E. B. White, The Elements of Style (4th edition, or 50th anniversary
edition, 1999/2009), the famous basic text on clear prose.
Noah Lukeman, The Art of Punctuation (OUP, 2006). Though apparently about
punctuation in ‘creative writing’, this is an excellent guide to punctuation overall – a very
useful book.
Claire Kehrwald Cook, Line by Line: How to Edit Your Own Writing (1985; Elsevier
Science, 2006). This is one of the finest books ever written about prose style, but it is
pitched at a high level. Its section on grammar is particularly helpful.
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1.2
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STYLISTIC CONVENTIONS

For the conventions of professional writing and referencing, we recommend you
look first at the section on Referencing below (section 10), but then, for more
detail, at parts of the following, also available in the library. These books don’t just
cover ‘style’.
MHRA Style Guide: A Handbook for Authors and Editors (3rd edition, Modern Humanities
Research Association, 2013). This is the work we recommend you use to style
coursework essays and Dissertations in English literature: i.e. how to do footnote
references, bibliographies, etc. It is easy to get hard copy, but it is available online free at
http://www.mhra.org.uk/pdf/MHRA-Style-Guide-3rd-Edn.pdf The section at the start, ‘A
Quick Guide to MHRA Style’, gives you most of what you need to know.
R. M. Ritter, New Hart’s Rules: the handbook of style for writers and editors (OUP, 2005).
This is a famous guide indeed. It is an abbreviated form of R. M. Ritter, The Oxford Guide
to Style (OUP, 2002).
MLA Handbook, ed. Joseph Gibaldi (Modern Language Association of America, 2016).
This is now in its 8th edition, but earlier editions are fine. While this is a different style
system to MHRA, this book does have interesting sections on plagiarism, punctuation, etc.

1.3

HIGH-LEVEL WORKS

For those who aspire to understand the high end of writing and editing, in
publishing contexts, there are two other invaluable books. If you have ever
wondered the best way to write that novelist’s name in English – whether
Dostoevsky, Dostoevski, Dostoevskij, Dostoevskii, Dostoyevsky, Dostoyevski,
Dostoyevskij, Dostoyevskii – these books tell you the answer. They also solve
issues of hyphenation: e.g. whether to write death bed, death-bed, or deathbed.
The Guardian Style Guide – available free on the web – is also good for these
things, if less comprehensive.
New Oxford Dictionary for Writers and Editors: The Essential A–Z Guide to the Written
Word, 2nd edition, ed. R. M. Ritter (Oxford, 2005)
New Oxford Spelling Dictionary: The Writers’ and Editors’ Guide to Spelling and Word
Division, 1st edition, ed. Maurice Waite (Oxford, 2005)
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SPELLING

Spell accurately at all times. In all professional publishing contexts, incorrect
spelling looks very bad and makes you appear naïve or incompetent. You need to
train yourself to get spellings right. Write your essays with a dictionary on your
desk, and check any meanings and spellings you are unsure of.
In Word, use the Spell Check, i.e. when a word is underlined in red, it is
probably wrongly spelt. Note, however, that there are quite a number of spellings
that are different between American English and British English (color/colour,
etc.). Make sure your Spell Check is set for British English: click Tools >
Language, then select English (UK). If you find yourself in America, spell
accordingly.
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If you check words using a dictionary and/or the Spell Check, gradually the
number of words you spell confidently and accurately will increase. The Concise
Oxford Dictionary is excellent. A fuller, excellent dictionary is The New Oxford
Dictionary of English (NODE) – there is a copy in the reference section of the
library. Another good dictionary is The Shorter Oxford English Dictionary: this is a
big, two-volume dictionary, and is good on the meanings of words in previous
centuries. For checking or understanding the meaning of words in older plays
or novels, scholars use the full Oxford English Dictionary, which is in 26
volumes. You will find a copy of this in the library reference section. This dictionary
is the greatest and fullest historical dictionary in any language. It is referred to in
abbreviated form as OED. You should use and explore it from time to time.
A good writer is someone fascinated by words and the way they work. Be sure
you really understand the meanings of the words you use. Good writers are
usually careful to understand the definitions of words and their correct use. The
Collins Cobuild Dictionary of the English Language and the Oxford Learners’
Dictionary are good for second-language speakers. Different dictionaries have
different strengths.
Remember that English has changed substantively as a language over the
centuries of its existence. This change is most radical between the eighth and the
fifteenth centuries, but it continues at a slower pace from early modern English
(Shakespeare’s English) to the present day. The meaning of a word in the
seventeenth century may in some cases be different from the meaning of that
word today. The Concise Oxford Dictionary gives you the contemporary meaning
of words. For the historical meaning of a word, you need to use something fuller,
like The Shorter Oxford English Dictionary or the full OED.
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PUNCTUATION

3.1 GENERAL
Even some professional writers are hesitant about punctuation, so don’t feel
ashamed if you don’t know how to use accurately the comma ( , ), the semicolon
( ; ), the colon ( : ), and the full stop ( . ), or parenthetical dashes, ( – . . . – )
and exclamation marks ( ! ). But now is the time to learn. The Grammar
Exercises – University of Bristol (as recommended in 1.1) are a great place to
start.
If you are unsure about punctuation, please study one of the following: Plain
English by Diane Collinson et al. (Buckingham: OU Press, 1992), chapter 2; the
section on punctuation in Claire Kehrwald Cook, Line by Line: How to Edit Your
Own Writing (1985; Elsevier Science, 2006); or the section called ‘The Mechanics
of Writing’ in MLA Handbook, all in the library. In Collinson, for example, work
through the examples, and check your answers. You will find many works advising
on punctuation in the English Language section of the library. Browse this section,
and make sure you gradually understand the correct use of the different points.
Also, when reading, notice how others use punctuation. Imitate their example.
Semicolon and colon cause most confusion. They are useful and you should get
used to deploying them properly.

4
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3.2 SEMICOLON ( ; )
You can usually only really put a semicolon in a place where you could also put a
full stop: it needs to come at the end of a whole phrase or sentence. What makes
it different to the full stop is that it indicates that the two sentence-units are part of
one larger unit of meaning. In other words, it is less emphatic than a full stop. Here
is a simple example of its use:
The cat sat on the mat; its fur was black. If you write
The cat sat on the mat, and its fur was black. . . . it sounds bland.

As Lukeman notes in The Art of Punctuation (see 1.1 above), this is the primary
function of the semicolon: ‘to connect two complete (thematically similar)
sentences, thereby making them one’. The semicolon has many subtle uses
though. For example, Lukeman again: ‘The semicolon can enhance word
economy, since its appearance often allows surrounding words to be cut’.
Example:
She couldn’t dance in her favourite ballroom because it was being renovated.
She couldn’t dance in her favourite ballroom; it was being renovated.

3.3 COLON ( : )
As Ritter explains, ‘The colon points forward: from a premise to a conclusion, from
a cause to an effect, from an introduction to a main point, from a general
statement to an example’. Example:
The weather grew worse: we decided to leave the beach.

The colon is used in the following ways:
■

To introduce a sentence or phrase that explains, illustrates, or amplifies
what has come before. It is a kind of pointer > pointing the reader to what
comes next. Example:
Scene 7 of the play is clearly an addition: it lacks both the authority and style of
the scenes that surround it.

■

The colon can also be used to introduce a list or series. Examples:
There are three ways of cooking eggs: boiling, scrambling, and frying. I like
scrambled eggs best.
Three different playwrights have been suggested as the author: Shakespeare,
Beaumont, and Webster.

■

The third main use of the colon is to introduce quotations, either short
quotations within your sentence or longer displayed or block quotations
(see section 6). By and large, you should only use a colon where you
could use a full stop – it needs to come at a complete pause in the rhythm
of the sentence – but again its function is to point the reader onwards and

English Department WRITING GUIDE

5

to draw attention to the words that follow. Examples:
Everyone knows Hamlet’s most famous line: ‘To be or not to be, that is the
question’.
Frank Kermode’s understanding of Hamlet can best be summarised by what he
says at the beginning of chapter 3: ‘Those who argue for oedipal readings need
to clarify their overall viewpoint’.

■

BUT, in a different phrasing – without the full pause – you do not need the
colon. Examples:
Everyone knows Hamlet’s most famous line is ‘To be or not to be, that is the
question’.
Frank Kermode has argued that ‘those who argue for oedipal readings need to
clarify their overall viewpoint’.

■

One last, but rare, use of the colon, is to direct attention to a word or
phrase in apposition to another. This is an emphatic use and should be
used sparingly. Example:
He had only one pleasure: eating.

3.4 EXCLAMATION MARK

( ! )

In critical and analytical prose, be wary of using exclamation marks at all. (It is a
different matter when writing fiction, where you need exclamation marks to indicate
emphases in characters’ speech.) In literary-critical contexts exclamation marks
are now almost never deployed; in most serious works they are rare. Even in more
popular discursive contexts, nothing betrays the jejune writer more obviously than
the tendency to overuse the exclamation mark. No less an authority than the great
Theodor Adorno says this:
Exclamation points, gestures of authority with which the writer tries to impose an
emphasis external to the matter itself, have become intolerable, while the sforzato, the
musical counterpart of the exclamation point, is as indispensable today as it was in
Beethoven’s time, when it marked the incursion of the subjective will into the musical
fabric. Exclamation points, however, have degenerated into usurpers of authority,
assertions of importance. (Notes to Literature)

So, you have been warned!
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3.5

PARENTHESIS BRACKETS AND DOUBLE DASHES: (

)

–

–

Double dashes are slower, but more emphatic, than parenthesis brackets.
Lukeman gives this good example:
Clocks made in Switzerland (particularly in Geneva) never break.
Clocks made in Switzerland – particularly in Geneva – never break.

As he aptly puts it, ‘it is the difference between a driver who politely interrupts you
to point out a sight along the way and a driver who slams on the brakes’. But
double dashes certainly have their uses: don’t be afraid of them. Theodor Adorno
makes these interesting points:
The test of a writer’s sensitivity in punctuating is the way he or she handles parenthetical
material. The cautious writer will tend to place that material between dashes and not in
round brackets, for brackets take the parenthesis completely out of the sentence, creating
enclaves, as it were, whereas nothing in good prose should be unnecessary to the overall
structure. But admitting such superfluousness, brackets implicitly renounce the claim to
the integrity of the linguistic form and capitulate to pedantic philistinism. Dashes, in
contrast, which block off the parenthetical material from the flow of the sentence without
shutting it up in a prison, capture both connection and detachment. But just as blind trust
in their power to do so would be illusory, in that it would expect of a mere device
something that only language and subject-matter can accomplish, so the choice between
dashes and brackets helps us to see how inadequate abstract norms of punctuation are.
(Notes to Literature)

For the other, more standard punctuation marks, see some of the works
suggested in Section 1.

4

PARAGRAPHS

Use paragraphs. If you have written a whole page without a paragraph-break, look
for where to put one. Paragraphs break up your argument and give it clarity. They
refresh the reader, giving her or him a new start, emphasizing you are
commencing a new point or idea, a new phase of your thinking.
In typing, you put in a paragraph-break by using the Enter key (on the righthand side of the keyboard), and then, to indent, the short space or Tab key (on the
left-hand side of the keyboard, with little arrows pointing both ways). This indents
the first line of the paragraph you are working on – as at the beginning of this
paragraph. An alternative procedure is not to indent, but to set off the whole block
of each paragraph by using the Enter key (on the right-hand side of the
keyboard), i.e. to leave a whole clear line between two paragraphs. If you look
back in this guide, section 2) Spelling shows you the first method, and, looking
forwards, section 6) Referring to Critics shows you the second. Examples:
need to clarify their overall viewpoint.’
Elsewhere in his writings, Kermode also examines . . .
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Or
need to clarify their overall viewpoint.’
Elsewhere in his writings, Kermode also examines . . .

The first method is preferable. You will notice that the standard tab indent on Word
is quite large. You can reduce it, by blocking text, and then Format > Paragraph,
Special: ‘First line’, By: set 0·5 cm.

5

TYPING YOUR WORK

All coursework assignments and essays must be typed (unless the tutor indicates
otherwise). This gives a far more professional appearance, and universities insist
on it. It is a skill going forward. All professionally published material has to go to
press in typed form. Careers in all kinds of areas (teaching, print media,
publishing, etc.) will now expect you to write on computer, so if you haven’t done
this before, now is the time to start. Coursework will normally be submitted via the
VLE (Moodle) as a Word document. It should be in a sensible font and size: see
5.6.

5.1 DOUBLE SPACING.
Always double space your work, as in this paragraph. There is one main reason
for this. All material submitted for publication to publishers, journals, etc. is at first
double-spaced. This leaves space for an editor to suggest improvements or
corrections to your work. Because this is the familiar form, it also looks more
professional. It may at first look strange to your eye, but it is very much the usual
format for submitting material to publishers. Examiners prefer it. Block your text;
then, in Word, Format > Paragraph > Line spacing > Double.
5.2 SPACING
When typing material, leave an ordinary space after all main points of punctuation,
commas, full stops, semicolons, and colons.Don’t do what I have just done.Do you
see how crushed up it appears? This is the way to do it!
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5.3 PAGE NUMBERS.
Please put page numbers in your essays. Even if stapled, pages can become
loose. Page numbers allow your reader to get the essay in the right order.
5.4 DIACRITICAL MARKS AND SYMBOLS
e.g. á è % $, etc. can usefully be found on the Insert menu, at Symbol.
5.5

EXPLORING ‘Word’.

Explore Word to discover more of the ways in which your material can be
professionally presented. The Page Layout menu and other features lets you
adjust many aspects of spacing and paragraphing for a professional appearance.
5.6 DO NOT USE UNUSUAL OR NON-STANDARD FONTS
Use only the most normal fonts: Times New Roman, the most standard, is
excellent. Garamond, Georgia, Arial, and Century are all sensible fonts, set at 11
or 12. There are no marks for using ‘clever’ or fancy fonts. They are inappropriate
and distracting in the context of a formal essay.

6

REFERRING TO CRITICS

It is crucial that this section be read along with section 7 on PLAGIARISM, and in
conjunction with the departmental Handbook, section 3. (This is available on the
department webpage.)
6.1 GENERAL
A good essay, on literature, language, or indeed any other subject, will usually
have some reference to critics or experts. To refer to critics is not ‘unoriginal’. It
shows your learning, the breadth of your reading, and how you are participating in
contemporary debate about a given matter or a given work of literature. It always
gives your essay a more professional feel, and – unless used in a silly way – it will
always increase your mark or grade. (‘Originality’, as it is sometimes referred to, is
a silly idea. You are original whether you like it or not, from your genes and spirit in
the womb!)
Referring to critics shows you have risen above a false individualism: that you
value or appreciate the views and ideas of others, that you are in conversation
with other people’s ideas. In all serious areas of study – theology, philosophy,
politics, economics, the arts, etc. – showing your awareness of ongoing debate is
part of your growth in understanding within the subject.

6.2 WAYS OF REFERRING TO CRITICS
There are three main ways you can refer to the work of a critic you have read. To
illustrate them, we have chosen a passage from an essay by Michael Gearin-Tosh
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on Macbeth. The essay is ‘The Treatment of Evil in Macbeth’ (and it can be found
in Critical Essays on Macbeth, ed. by L. Cookson and B. Loughrey, Longman,
1988). Here is the extract:
Macbeth is evil, yet pity is essential to tragedy. Two ways in which
Shakespeare reconciles these opposites so that we pity a ‘hellhound’ (V. 6.
42) are the use of soliloquy and the strategies of the last two acts.
Macbeth contains more soliloquy as a proportion of the play than any
other drama by Shakespeare. Soliloquy can create intimacy with those we
do not like, as it does in Shakespeare’s other tragedy whose hero is evil,
Richard III, which was written some fifteen years before Macbeth. Richard
is also called a ‘hellhound’ (IV. 4. 48) but he is a ‘hellhound’ from the start.
He declares his villainy in the soliloquy which opens the play and we soon
learn that he has already moved against his first victim in the play, his
brother Clarence. Macbeth becomes evil, and his soliloquies chart the
stages of this degeneration.
This passage makes some important points about Macbeth. Let us imagine that,
having read it, you wanted to refer to some of these points in your own essay.
There are three main ways of going so.

■ PARAPHRASE. You can name Michael Gearin-Tosh (or whoever is the critic
concerned) and then put his arguments into your own words. Example:
Michael Gearin-Tosh notes that there is more soliloquy in Macbeth, as a percentage of the
play, than in any of Shakespeare’s major tragedies. As Gearin-Tosh argues, Shakespeare
uses soliloquy – our overhearing of the protagonist’s inner thoughts – to create intimacy
between the audience and Macbeth.3 Even if we sense Macbeth’s evil, it draws us nearer
to the inner workings of his mind.

Note, as here, you still need a footnote reference. In using paraphrase you need to
be careful not to plagiarize inadvertently (see Handbook, section 3, and also the
section on plagiarism below).
■ SHORT QUOTATION. When a particular phrase or sentence by a critic strikes
you as interesting, make a note of it in your notebook or computer, so that you can
use it in an essay. Sometimes short quotation may be just a vivid phrase,
sometimes it may be something a little longer. The quotation can be run-on or
embedded in your text. Such quotation will always improve your essay, giving lift
and impact. Example:
Shakespeare’s use of the soliloquy has always seemed crucial to the effect of Macbeth.
As Gearin-Tosh says, ‘Soliloquy can create intimacy with those we do not like’.3 Macbeth
is certainly someone we come to dislike in an obvious sense: he enters more and more
into a world of evil, into moral depravity. But soliloquy gives us access to his inner
thoughts, and in this way keeps us near to him. Gearin-Tosh contrasts Macbeth with
Shakespeare’s earlier evil protagonist Richard III: ‘Macbeth becomes evil, and his
soliloquies chart the stages of this degeneration’.4

10
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■ LONG QUOTATION. Sometimes it is appropriate to give a longer quotation from
a critic. Obviously, this cannot be done too often, otherwise your essay will
become a mere patchwork of long quotations. Your own argument, your voice, will
be missing. Nonetheless, occasionally, it can be a useful tool. It is best to quote a
longer passage when you find that it helps to build up your larger argument. Either
it helps you to illustrate what you have already said, or it helps you to go on and
build your own argument.
When you quote a passage that makes a longer quotation – more than about 50
words, say, or three or four lines – you should set it as a displayed or block
quotation. So, leave a clear, empty line between the end of your sentence and
the start of the quotation, and also inset the quotation from the margin. This
imitates the format in most books. In Word, to inset a quotation in this way –
whether from critic, play, poem, etc.– you should block the text concerned, and
use the Increase Indent (or Decrease Indent), on the Home menu, in the top row
of tools, in the middle. Here is an extract from an essay with a displayed
quotation in the middle of it. Example:
Shakespeare has to keep the audience in some kind of sympathy with Macbeth, and his
main strategy for doing so is his use of soliloquy. Gearin-Tosh has emphasized the
importance of soliloquy, and in so doing, noted an important difference between Macbeth
and Richard III:
Macbeth contains more soliloquy as a proportion of the play than any other drama
by Shakespeare. Soliloquy can create intimacy with those we do not like, as it
does in Shakespeare’s other tragedy whose hero is evil, Richard III . . . he
[Richard] is a ‘hellhound’ (4. 4. 48) from the start. . . . Macbeth becomes evil, and
his soliloquies chart the stages of this degeneration.3
Gearin-Tosh raises a number of important points here, and I want to take some of them
further. First, there is the interesting contrast between Macbeth (1606) and the earlier
play Richard III (1593). Second, there is the interesting point that. . . [and so your
argument takes off from there].

7

PLAGIARISM

If you follow the advice in section 6 above, you will not have to worry about
plagiarism. It is good to refer to and to quote other people’s ideas. Plagiarism,
however, is when you take other people’s words and ideas and then pretend they are
your own, by not distinguishing clearly between your own words and words you have
borrowed. It is basically a form of stealing, only you are stealing other people’s words
(rather than stealing their things): you are not acknowledging the source of your
ideas or your words. For more detail on plagiarism, please see the departmental
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Handbook, section 3 (in particular the quiz), and also the MLA Handbook, the section
‘Plagiarism and Academic Integrity’. Here is a definition of plagiarism:
Plagiarism may take the form of repeating another’s sentences as your own,
adopting a particularly apt phrase as your own, paraphrasing someone else’s
argument as your own, or even presenting someone else’s line of thinking in
the development of a thesis as though it were your own. In short, to plagiarize
is to give the impression that you have written or thought something that you
have in fact borrowed from another person. Although a writer may often use
another person’s words and thoughts, they must be acknowledged as such.
The following example is intended to show clearly what plagiarism is and what it is
not. It refers to the passage of criticism already quoted at the beginning of section
6.2.
THIS IS NOT PLAGIARISM:
Shakespeare’s use of the soliloquy has always seemed crucial to the effect
of Macbeth. As Gearin-Tosh says, ‘Soliloquy can create intimacy with those
we do not like’.3 Macbeth is certainly someone we come to dislike in an
obvious sense: he enters more and more into a world of evil, into moral
depravity. But soliloquy gives us access to his inner thoughts, and in this
way keeps us near to him. Gearin-Tosh contrasts Macbeth with
Shakespeare’s earlier evil protagonist Richard III: Richard starts off as evil,
but ‘Macbeth becomes evil, and his soliloquies chart the stages of this
degeneration’.4
THIS IS PLAGIARISM:
Shakespeare’s use of soliloquy has always seemed crucial to the effect of
Macbeth. Soliloquy can help to create a feeling of intimacy with characters
we do not like. Macbeth is certainly someone we come to dislike in an
obvious sense: he enters more and more into a world of evil, into moral
depravity. But soliloquy gives us access to his inner thoughts, and in this
way keeps us near to him. Macbeth can be contrasted in an interesting way
with Shakespeare’s earlier evil protagonist Richard III, but unlike Richard,
Macbeth becomes evil, and his soliloquies chart the stages of this
degeneration.
In this second passage, there is no indication whatsoever that some of the
thoughts and phrases come from the critic Gearin-Tosh. Two of the sentences
derive directly from Gearin-Tosh’s essay, but his name is not mentioned: there are
no quotation marks, and there is no attempt to reference these sentences. Even
though the phrasing of these sentences is slightly altered from the original, this still
counts as plagiarism. When in doubt, always mention your source or the critic’s
name, using phrases like ‘as Gearin-Tosh has argued . . .’, ‘Gearin-Tosh says that
. . .’, ‘one critic has said that . . . ’ and giving a footnote reference.
Plagiarism in a serious failure of integrity and honesty.
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Here, as at other universities, an essay which is judged to contain plagiarism may
be graded at 0%. (The university’s full plagiarism policy is available on the web.)
Don’t worry about plagiarizing by accident. Simply be honest about where your
ideas come from, and use quotation marks around material directly quoted from
critics, internet sources, or any other material. The Turn-it-in programme easily
identifies plagiarism, so please avoid it at all costs.
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BIBLIOGRAPHY

8.1

GENERAL

Most coursework essays require bibliographies at the end. The bibliography
should include the works you have directly referred to in your essay and also other
works, which, though you have not directly referred to them, have nonetheless
acted as background to your understanding of the subject. The books and articles
you have used should be listed in alphabetical order by author’s surname. The
order of reference should be in a consistent form. We recommend the MHRA
system, which works as follows, for books:
Author’s surname, then first name or initials, Title of work in italics (place of
publication: publisher, date)
And for articles in journals:
Author’s surname, then first name or initials, ‘Title of article’ (in quotation
marks), Journal name, volume number (year of publication), page range

8.2

MODEL BIBLIOGRAPHY

Here is a simple model Bibliography for a coursework essay on F. Scott
Fitzgerald’s novel The Great Gatsby. It shows you how to refer to (a) a main
edition you have used, (b) an essay in a collection of essays, (c) an article in a
journal, and (d) three ordinary books.
Bibliography
All in-text references are to The Great Gatsby, ed. by M. J. Bruccoli (Cambridge:
Cambridge University Press, 1991)
Garrett, George, ‘Fire and Freshness: A Matter of Style in The Great Gatsby’, in
New Essays on The Great Gatsby, ed. by M. J. Bruccoli (Cambridge:
Cambridge University Press, 1985)
Goldsmith, Meredith, ‘White Skin, White Mark: Passing, Posing, and Performance
in The Great Gatsby’, Modern Fiction Studies, 49 (2003), 440–49
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Hook, Andrew, F. Scott Fitzgerald (London: Edward Arnold, 1992)
Lee, Brian, American Fiction 1865–1940 (London: Longman, 1987)
Tredell, Nicolas, Icon Critical Guides: The Great Gatsby (Cambridge: Icon Books,
1997)

8.3

INTERNET SOURCES

In essays it is good to cite books and articles (as on JSTOR). Be wary of how you
use and cite websites. Often they are not authoritative enough.
Internet sources are probably best given in the form recommended by New Hart’s
Rules, with the URL between pointers <
>, or at least some approximation to
this form. It is best to find an individual author to whom to attribute the web
material, but if this is not possible, cite it by a title of some kind. Here are the
examples given in Hart’s New Rules:
Quint, Barbara, ‘One Hour to Midnight: Tasini Oral Arguments at the Supreme Court’,
Information Today [online journal], 18/5 (May 2001)
<http://www.infotoday.com/newbreaks/nb010330-1.htm> accessed 1 July 2001
[The] Bibliographical Society [website]<http://www.bibsoc.org.uk/>accessed 1 Oct 2004
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QUOTING YOUR MAIN TEXT

When you are writing about a work of literature, you should always try to quote
short extracts, phrases, or lines from it in order to illustrate your points and give
substance to your argument. This section discusses how to do so.
9.1

QUOTING FROM POETRY

Poems are divided into lines, and how the lines are arranged – their lineation – is
important to their rhythm and to how we voice them. When quoting poetry you
need to make clear where the line-endings are. Remember that Shakespeare’s
plays, for example, are often written in poetry (i.e. blank verse) and, where this is
the case, you again need to indicate the line-breaks, or set then out properly in a
displayed or block quotation. Here are some simple examples showing how to
quote properly from the poem ‘Vergissmeinnicht’ by Keith Douglas. Here is the fifth
stanza as it looks in a book:
But she would weep to see today
how on his skin the swart flies move;
the dust upon the paper eye
and the burst stomach like a cave.

14
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If you quote the whole of this stanza, the lines should appear as in the original
book and also inset (as above). Unlike the book, however, they should be double
spaced. When quoting and insetting poetry, you must keep the original lineation,
as this is part of the poem’s effect.
If you quote just two lines of this poem or any other poem, you can keep it within
your own text, but you need to add in the oblique solidus, i.e. / , or vertical
solidus, i.e. | , to indicate the line-ending. Example:
In the fifth stanza of the poem, Douglas heightens the alliteration and the linked vowels,
suddenly raising the intensity of the language: ‘But she would weep to see today / how on
his skin the swart flies move’ (17–18). ‘Weep’ catches up the sound of ‘swart’ in an
unusual and beautiful way. [etc.]

If you are quoting more than two lines of the poem, you will need (as in quoting
criticism) to leave a free line and then inset the quotation. The line-breaks should
appear as in the original. After the quotation, you should leave another free line. In
this way, the quotation is highlighted within the text. Example:
Douglas’s poem moves to its climax in the fifth stanza, in which the language is
heightened through alliteration and interlinked vowel sounds:
But she would weep to see today
how on his skin the swart flies move;
the dust upon the paper eye
and the burst stomach like a cave.
(17–20)
Here the ‘ee’ sound in ‘weep’ and ‘see’ links the words together, but there are other
heightening effects. [etc.]

9.2

QUOTING PROSE WRITINGS AND NOVELS

Here the same rules apply as for quoting criticism. You do not need, however, as
with poetry, to reproduce the original lineation. If the quotation is fewer than about
50 words, or three or four lines, you can keep it in the body of your text. See the
example in 6.2 Short quotation. If it is longer than about 50 words, or three or
four lines, it needs to be set as a displayed or block quotation (see 6.2 Long
quotation). Style systems are rightly vague about how many words long a
quotation needs to be, to be treated as a block quotation. In other words, use your
discretion, in relation to the material.
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REFERENCING

10.1

GENERAL

15

When you start out, you are not expected to reference fully all your work. But, as
soon as possible, you should attempt to get some idea of accurate referencing. In
particular, coursework essays (when they count towards your final degree) should
be properly referenced. (Referencing is not expected in exams.)
What does referencing mean? When you quote from a given text or critic, you give
a reference to indicate the work and the page within the work. In this way,
someone who wants to follow up your ideas can trace your quotations to their
original sources and verify your argument.
We strongly recommend use of the MHRA system, but we briefly indicate here two
other systems as well, so you can know about these by way of comparison. MHRA
is very close to the Oxford University Press (OUP) system (i.e. Hart’s New Rules).
There are only small differences. Here is a brief explanation of each system. For
the full versions, see the MLA Handbook, the MHRA Style Guide (3rd edn), and
Hart’s New Rules respectively. In section 18, at the end of this Guide, you will find
model sample pages of essays styled correctly to the three systems.
10.2

MLA REFERENCING

In this system, when you quote from a source, after the quotation you simply put
the author’s name and the page number in brackets. So, let’s imagine you have
been reading parts of Nicholas Roe’s Wordsworth and Coleridge: The Radical
Years (1988), to help you with an essay about the Romantic poets and politics.
This is how you might quote and reference it:
In the early 1790s Wordsworth opposed the war with France, wanted the English
monarchy abolished, and hated the suffering he saw among the ordinary people, but in
the end, as the Revolution in France went bad, he developed from ‘poet of protest to poet
of human suffering’ (Roe 137).

Or course, if you mention Roe’s name within your own text, you don’t then need to
repeat his name in the bracketed reference. So:
In the early 1790s Wordsworth opposed the war with France, wanted the English
monarchy abolished, and hated the suffering he saw among the ordinary people, but in
the end, as Roe argues, he developed from ‘poet of protest to poet of human suffering’
(137).

In both instances – in all instances – the book must then be listed in your
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Bibliography. Thus:
Roe, Nicholas, Wordsworth and Coleridge: The Radical Years (Oxford: OUP, 1988)

In the case of website material, where there is not one named author, use the title
in a conveniently shortened form. So, after a quotation from the website listed in
8.3, the bracketed reference would simply be (Bibliographical Society).
10.3

MHRA REFERENCING

The MHRA system of referencing uses footnotes at the bottom of the relevant
page, not bracketed references in your text. The footnote facility is available under
the References menu in Word. So, the same example above, would now look like
this:
In the early 1790s Wordsworth opposed the war with France, wanted the English
monarchy abolished, and hated the suffering he saw among the ordinary people, but in
the end, as the Revolution in France went bad, he developed from ‘poet of protest to poet
of human suffering’.1

See the footnote at the bottom of this page. If you refer to the same work again in
your essay, the next footnote can be shorter, just giving the author’s name and the
page number. So, again, see the bottom of this page.2 To see how to footnote an
article, see the bottom of the page again.3 You need the volume number and the
year of publication. As the MHRA Style Guide says (1.3.10), ‘Footnote numbers
should be inserted following any punctuation except a dash, and at the end of the
sentence if possible’, i.e. the footnote number comes after a full stop and after a
comma or semicolon, not before. (See the example above.)
Again, in this system, please also list the book or article in the Bibliography.
10.4

OUP (or Hart’s New Rules) REFERENCING

The OUP, or Hart’s New Rules, system, is basically the same as MHRA, though in
this system you can get away with the minimum of information, if you want to, and
avoid giving the publisher’s name in your note, or the p. or pp. for page or pages.
So, the footnote would just be:
1

Nicholas Roe, Wordsworth and Coleridge: The Radical Years (Oxford, 1988), 137.

This is elegant in its simplicity.

1

Nicholas Roe, Wordsworth and Coleridge: The Radical Years (Oxford: Oxford University Press, 1988), p. 137.
Roe, p. 178.
3
J. C. Maxwell, ‘Wordsworth and the Subjugation of Switzerland’, Modern Language Review, 65 (1970), 16–18 (p. 17).
2
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This is how to arrange the footnote for a journal article:
1

J. C. Maxwell, ‘Wordsworth and the Subjugation of Switzerland’, Modern Language
Review, 65 (1970), 17.

Again, in this system, please also list the book or article in the Bibliography.

For all these systems, please see the model essay pages at the end of this
Guide.
In the Bibliographies, of course, you swap round the first name and surname, and
take away the specific page reference – thus, in MHRA style:
Roe, Nicholas, Wordsworth and Coleridge: The Radical Years (Oxford: Oxford
University Press, 1988)

See Section 8 Bibliography for full details.

11
11.1

POINTS OF STYLE
QUOTATION MARKS, DOUBLE/SINGLE

Generally English style uses single quotation marks, ‘ ’, while style systems in the
USA use the older double quotation marks “ ”, but this is not universally true. UK
print journalists often prefer double quotation marks, as they are used in the
quality UK newspapers. Then again many people believe that single quotation
marks are easier to read on the web. When writing about literature, we prefer you
follow normal modern British practice, i.e. single quotation marks. When writing for
journalism assignments, it is double for print, but please consult your tutors in
relation to web writing.
When you quote someone else, and within the quotation they quote something,
you can indicate this by then moving to double quotation marks. Example:
Hans Gubermatch says that Macbeth ‘goes into something like madness with his soliloquy
“Is this a dagger” ’ as he approaches near to the point of the murder.

11.2

FIRST NAMES AND SURNAMES

The first time in an essay that you refer to a poet/novelist/dramatist you might
choose to give both first and second names, e.g. Charlotte Brontë’s Jane Eyre,
Robert Frost’s ‘Two Look at Two’, Katherine Mansfield’s ‘At the Bay’, or E. M.
Forster’s A Room with a View. But thereafter just use the surname. This is simpler
and saves you and your reader time. It is unnecessary with well-known writers to
use both names: William Shakespeare, John Keats, Charles Dickens . . . no . . .
there is not a Maurice Shakespeare, Frederick Keats, or a Gary Dickens, so no
confusion is likely!
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AVOID NEEDLESS REPETITION

Don’t overly repeat the name of the author or the title of a work (poem, play, novel)
you are talking about. If you have begun a discussion of a given work, you don’t
need to keep using its name (Macbeth . . . Macbeth . . . Macbeth, or Dickens . . .
Dickens . . . Dickens) unless your reader might have some reason to think that
you have changed the subject and moved onto something else.
11.4

AVOID THE OBVIOUS

Do not waste sentences by saying the very obvious, particularly facts, unless
these are relevant to your argument. Assume a sophisticated reader (which your
external examiner, usually a Professor at another university, certainly is!) and not
an alien newly arrived from Mars. So, do not begin an essay like this: ‘Hamlet is
one of the group of Shakespeare’s tragedies. It was probably written in 1600. It
represents a marked change of atmosphere and style from the plays preceding it.’
Cut the two sentences designed for the Martian, and get straight into the
essentials of what you are saying – thus: ‘Hamlet (1600) represents a marked
change of atmosphere and style from the plays preceding it. . . .’. And you are off!
11.5

CORRECT USE OF ITALICS

Set in italics the names of full-length published works: i.e. Macbeth, Jane Eyre,
Great Expectations. In exams, indicate italics by underlining such titles: Macbeth,
Jane Eyre, Great Expectations. This is the equivalent of italics in published
material.
This traditional system has many advantages, notably clarity. But also, you don’t
have to say: ‘Macbeth’s character shows . . .’ or ‘In the play Macbeth . . .’ because
Macbeth [in italics] always means the play; Macbeth [without italics] always means
the character within the play.
Short works (e.g. individual short poems, short stories, chapters of books, critical
essays, etc.) are not in italics. They just take single quotation marks: ‘Two Look at
Two’, ‘Strange Meeting’, ‘The Birthday Party’. A whole volume of poems on the
other hand (e.g. a complete longer work, published as such) does take italics.
Again, this makes for accuracy and simplicity. Philip Larkin wrote a volume of
poems called Whitsun Weddings – when written in italics like this, it indicates you
are referring to the whole volume of poems. He also wrote an individual short titlepoem to the volume called ‘Whitsun Weddings’. The difference between italics (or
underlining) and single quotation marks indicates immediately which you mean,
without having to indicate this in any other way. So, also, with Katherine Mansfield:
The Garden-Party indicates the whole volume of short stories of that name
published in 1922; ‘The Garden-Party’ indicates the single short story within the
volume from which the volume takes its title.
There is a short poem by Robert Frost called ‘Two Look at Two’. Because it is a
short poem (part of a larger volume) it should be as here, in single quotation
marks. For titles of works never use italics and quotation marks together. It is one
or the other. Do not write ‘Two Look at Two’.
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SOME POINTS ABOUT NUMBERS

In writing about a novel refer to chapter 2, not chapter two. In writing about a play,
in an ordinary sentence (not a reference), it is now most common to use arabic
(not roman) numbers: i.e. in Act 1, in Act 2, in Act 3, etc. In references, after
quotations, use the form (4. 3. 120-25), meaning Act 4, scene 3, lines 120 to 125.
When, in your ordinary sentences, you refer to an Act and a scene within it, you
can use the form ‘in 4. 3’ or ‘in Act 4, scene 3’. Don’t, however, write ‘in Act four,
Scene three’, which is cumbersome. Use numbers not words for line numbers in
poems. So, write ‘In lines 20–25 of the poem . . .’ rather than ‘in lines twenty to
twenty-five . . .’. Ages, as adjectives, are now usually done with a combination of
numbers and words, e.g. ‘We do not know much about the 19-year-old
Shakespeare.’
11.7

DATES

English and American forms for historical dates are usually different, and there is a
variety of English forms. Generally, we would recommend the use of the form
preferred by OUP and The Guardian, i.e. 2 October 1960 (day, month year). In
other words, you don’t put in the ‘nd’ on ‘2nd’ or ‘of’ (as in 2nd of October 1960). You
should be aware of other forms preferred in England and the US. So, you should
write, for example
Shakespeare was born on 26 April 1564.
In the US, this would characteristically be Shakespeare was born on April 26,
1564.
Do NOT, however, write any of the following:
Shakespeare was born on the 26th April 1564.
Shakespeare was born on 26th of April 1564.

12
12.1

FURTHER POINTS

‘VERY’

Avoid the use of very. It is overused. Its effect is an emotive insistence on the
statement being made, which is usually a cover for the relative absence of
accuracy or rationality. Everything is very interesting, very striking, very difficult,
etc., and in the end this becomes very, very boring indeed.
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REDUNDANT WORDS

It is not necessary to write: ‘John Smith, in [his book] Shakespeare’s Tragedies, . .
.’ or ‘Milton, in [his poem] ‘Lycidas’. . .’, Blake, in [his poem] ‘Jerusalem’ . . .’ or
‘Charles Dickens in [his famous novel] Great Expectations . . .’. The words in
brackets in these sentences are redundant, in the first instance because the italics
or quotation marks indicate that these are books or poems, and also because you
should assume an educated reader who knows this information.
12.3

REDUNDANT PHRASES

Another overused phrase is ‘It is very interesting to note that . . .’ and similar
phrases. The phrase is redundant, and creates an unnecessary feeling of
insistence. So, observe the following sentence with and without the phrase: ‘[It is
very interesting to notice how] Hardy sets himself against the loud noises of public
discourse, deliberately creating in his poems a private space of intense feeling that
challenges the hollowness of large formulas and overblown publicity.’ The opening
phrase adds nothing to the sentence and should be dropped.
12.4

SIGNPOSTING

Avoid backward and forward signposts: ‘as I argued above’, ‘as I said at the
beginning of this essay’, ‘as we have already said’, ‘as I will argue later’, ‘as we will
see in a minute’. These are usually unnecessary. Try and avoid them. If you need
to repeat a point in your argument, simply repeat it. Don’t repeat it and say that
you are repeating it. If you have already argued something, it is fine to repeat it
without having also to draw attention to the fact that you are repeating it. Trust the
reader’s memory.
12.5

HUMANKIND/MANKIND

‘Humankind’ or ‘humanity’ are now generally preferred to ‘mankind’, though their
use can pose difficulties.

12.6

PRESENT TENSE AND PLOT

Always use the present tense when describing the actions taking place within a
play, novel, or poem. The action within a work of imagination is always assumed to
be taking place now. Use the present tense when describing plot. Examples:
At the beginning of 1.7 Macbeth’s imagination is overheated. Now he is
contemplating murder seriously for the first time. He is struggling to overcome his
conscience . . .
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or
In chapter 6 of A Room with a View all the main characters go on a picnic together to
a high look-out point above Florence. The Italian driver of one of the carriages kisses
his girlfriend, and when Mr Eager sees this he becomes annoyed and starts arguing
with them.

This use of the present tense is difficult, and takes some getting used to. The
Longman style guide puts it like this:
When you are relating the events that occur within a work of fiction or
describing the author’s technique, it is the convention to use the present
tense. Even though Orwell published Animal Farm in 1945, the book
describes the animals’ seizure of Manor Farm. Similarly, Macbeth always
murders Duncan, despite the passage of time.
12.7

ELLIPSIS

( … )

An ellipsis, indicating omitted words, should be only three dots … not …... or ………
In typing, the dots should either be separated by space-bar gaps, or you can use the
stable ellipsis … to be found under Insert, Symbol. If you wish to indicate an
omission that starts before the end of a sentence and continues on into a different
sentence, use four dots: one for the period or full stop at the end of the sentence and
the three for the ellipsis. It is not normally necessary to use an ellipsis at the
beginning or end of a quotation, usually only in the middle.
12.8

PAGE NUMBER ABBREVIATIONS

In references, p. is short for ‘page’ and pp. is short for ‘pages’. So, p. 49, but, if you
are referring to a page range, pp. 49–52. You can’t refer to p. 49–52. It’s a singular,
where you need a plural.

13

THE APOSTROPHE

The apostrophe s (’s) causes a great deal of unnecessary trouble. Here is a brief
explanation of its correct use.
13.1

THE POSSESSIVE APOSTROPHE

The apostrophe (’) often indicates the possessive case of nouns and indefinite
pronouns (e.g. anyone, anybody), that is to say, it indicates when something or
someone belongs to someone else. Examples:
Shakespeare’s plays
the poet’s approach
it is anyone’s guess Hardy’s death
Kermode and Steinbeck’s interpretation
for goodness’ sake
‘The poet’s approach’ means the approach of one poet; if it were more than one
poet, then: the poets’ approach.
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Notice this difference between the singular and plural apostrophe. Example:
Singular

Plural

the boy’s ball
the boys’ ball
(i.e. the ball belonging to one boy) (i.e. the ball belonging to a group of boys)
You only add the apostrophe on to the name; you never shorten the name. So,
with names already ending in s you add ’s, unless the sound becomes very
awkward, when you might only add ’. Keats: therefore, Keats’s poetry (never
Keat’s); likewise Hopkins: therefore, Hopkins’s poetry (never Hopkin’s); likewise
Dickens: therefore, Dickens’s novels.
13.2

THE APOSTROPHE FOR CONTRACTIONS

The apostrophe can be used to indicate left-out letters in contracted words: didn’t
= did not; hadn’t = had not; isn’t = is not. Generally, in formal writing, avoid the use
of such contractions as much as possible, unless it seems awkward or overly
formal to do so.

14

IT’S AND ITS

The words ‘it’s’ and ‘its’ are commonly confused: the apostrophe of omission (it’s)
is confused with the possessive (its). It’s always means it is or it has, and is
never to be used in place of the possessive its. Example:
It’s a beautiful day = it is a beautiful day

(The apostrophe simply indicates the contraction; it stands in for the missing ‘i’.)
In formal writing, unless it would be awkward, it is best to avoid this contraction, as
I have just this moment avoided it in this sentence (not ‘it’s best to avoid…’). BUT
the possessive use does not take an apostrophe:
Examples:
The cat sat on the mat. Its fur was smooth and dark.
The qualities of Macbeth that most strike us on first reading are its brevity and
passion. I do not know which of its characteristics I admire most.

Its (the possessive) takes no apostrophe because it is on a par with the other
possessives, his and her: his head, her head, its head.

English Department WRITING GUIDE

15

23

DASHES

There are three lengths of dashes, each a little longer than the other: the hyphen , the ‘en’ dash – , and the ‘em’ dash — . Their correct use is as follows.
15.1

HYPHEN -

You probably already know about the hyphen. It is worth noting, however, that the
number of hyphenated words is tending to reduce in English. Words that were
hyphenated are often now tending to lose their hyphens: so, a word like ‘mind-set’,
for example, is now usually written ‘mindset’. If in doubt, check your dictionary.
The Oxford dictionaries are particularly good on this. You can also look in the
online Guardian Style Guide, or the New Oxford Spelling Dictionary (see 1.3).
15.2

EN DASH

–

The slightly longer en dash is correctly used to give ranges of numbers or dates,
particularly with the abbreviations pp. (which is short for ‘pages’) and ll. (which is
short for ‘lines’). In Word, you will find en dashes under Insert, Symbol, but the
quickest way to put them in is Ctrl and (num) – (i.e. the minus sign on the far right
of the keyboard), pressing these keys at the same time.
Examples:
(pp. 29–30)
15.3

EM DASH

lines 50–5 lines 125–9 (ll. 50–5) 1999–2001

4. 3. 34–35

—

The longest dash, the em dash, is mainly used—as most writing guides will show
you—for parenthetical dashes (as we have just used it in this sentence). Again, in
Word, it is under Insert, Symbol, but is easiest to do with Ctrl + Alt + (num) - .
You can use em dashes for parenthetical dashes, but there is now a strong
tendency to use en dashes with spaces either side (as in this Guide). So, the first
sentence would become: The longest dash, the em dash, is mainly used – as most
writing guides will show you – for parenthetical dashes. We do not mind which
form you use, but clearly one should not just use hyphens in these contexts.
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AVOIDING PLOT PARAPHRASE

This is a hard point to grasp, but you will get few marks for simply and uncritically
retelling the plot or story of the poem, short story, novel, or play you are writing
about. You should assume an educated reader, one who knows the great books and
works you are studying, one who already knows, for example, the basic plots in
Macbeth, Great Expectations, Paradise Lost, etc.

24

English Department WRITING GUIDE

Of course there is a difference here between simply and uncritically telling the story,
and telling the story because you are also making critical, interpretative, or evaluative
comments. The latter are good. To show the difference between the unsophisticated
retelling of the story, and storytelling that is serving a critical purpose, we take
Raymond Carver’s famous short story ‘Fat’ as an example. The following is the kind
of relatively naïve account of the plot that we urge you to avoid:
In the story a fat man comes into a restaurant, and the waitress goes to serve him. The
waitress and the fat man have a long conversation, during the time in which she brings him
the various parts of his meal. After the restaurant has closed, the waitress goes home with
her husband or partner, Rudy, and they again speak about the fat man. The story ends with
the waitress speaking to her friend Rita.

The above will not get you many marks because it simply relates the story’s plot in
relatively unsophisticated terms. Here, however, is the same passage with critical,
interpretative, and evaluative comments. This is much better:
In the story a fat man comes into the restaurant, but we see this event from the waitress’s
point of view, for the story is dominated by her first-person narration. The waitress and
the fat man have a long conversation, but during this conversation Carver keeps his
authorial presence well out of view: he demands of us, as readers, that we try to make
sense of what is happening emotionally during the conversation for ourselves. After
the restaurant has closed the waitress goes home with her husband or partner, Rudy, but
there seems to be something anticlimactic here: as readers we begin to be puzzled
about where the story is really taking us.

17

WIDER THINKING

Literary criticism relies in the last analysis – some critics would argue, is inextricably
linked to – a wider understanding of politics, philosophy, psychology, theology,
sociology, and history. Here it is impossible to cut corners, but clearly the extent of
your understanding and life-experience in extra-literary realms will affect your
possible understanding of literature. This is one of the things that makes the study of
literature so exciting. If you have time to read or think more widely, this is excellent.
Debating basic issues among yourselves (or sometimes with your tutors!) can help to
achieve subtler, more accurate, more truthful thought. Bear in mind Alistair
MacIntyre’s wise observation: ‘It has become increasingly plain that whether a man
calls himself a Christian, a Marxist, or a liberal, may be less important than what kind
of Christian, Marxist, or liberal he is’. If you have time (and you may not) the following
are excellent (most are in the library):
Herbert McCabe, The Good Life
Roger Scruton, Modern Culture (formerly published as The Intelligent Person’s
Guide to Modern Culture)
Roger Scruton, Culture Counts: Faith and Feeling in a World Besieged
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Stanley Cavell, Must we Mean What we Say?: see the great philosophical essay on
King Lear, ‘The Avoidance of Love’
Mary Midgley, The Solitary Gene: Darwin and the Selfish Gene
Mary Midgley The Essential Mary Midgley
Richard Sennett, The Culture of the New Capitalism
Herbert McCabe, God Still Matters
Rowan Williams, The Edge of Words
Rowan Williams, Being Human: Bodies, Minds, Persons
Study should be a joy. It is finding out more about yourself, others, and the world.
One important way of doing well is to be friends with the other people in your year.
You can learn a great deal by debate and discussion, by watching a Shakespeare
play on dvd with a few friends and then talking through responses; debating a
critical essay or approach; finding out what someone else found useful reading on
a particular subject. Another way of doing well is to practise and so get to enjoy
writing essays, to overcome gradually essay-writing phobia. The discipline of
setting down thought and argument, of articulating exactly what you mean, is the
process by which the mind naturally grows into a real understanding of itself and
its subject.
Mastering the craft of good prose is an exacting but exciting challenge. We want
everyone who undertakes a degree in the English Department to go out into the
world, or to continue into further study or training, knowing they have acquired real
high-level writing skills. Good luck! And always ask for help if you need it.
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MODEL ESSAY PAGES - CORRECTLY STYLED: this page MLA

Essay question: Compare and contrast the interplay between politics and poetry in
the work of two of the Romantic poets you have studied on the course.
Like many liberals in England, Wordsworth was deeply moved by the French Revolution
of 1789, seeing it at welcome sign of greater political freedom to come. One critic notes
‘the swiftness with which Coleridge had developed from distracted undergraduate early in
1794 to take a prominent and active role in contemporary radical affairs’ (Roe 117).
Wordsworth’s viewpoint is well summarized in a letter sent to his friend Matthews in June
1794:

I disapprove of monarchical and aristocratical governments, however, modified.
Hereditary distinctions and privileged orders of every species I think must necessarily
counteract the progress of human improvement. (Roe 157)

Wordsworth, like Coleridge, wanted a large increase in the number able to vote in
elections, very few at this time. As he wrote in ‘A Letter to the Bishop of Llandaff’: ‘If
there is a single man in Great Britain, who has no suffrage [vote] in the election of a
representative . . . he is a helot [slave] in that society’ (Wordsworth 156). One of Coleridge’s
most obviously political poems, which I will discuss in the next few pages of this essay, is
‘Fears in Solitude’, where he makes clear how his religious faith lies at the centre of his
radical politics. He deplores atheism, which he compares to an owl ignoring the sun (i.e.
God):
(Portentous sight) the owlet, ATHEISM,
Sailing on obscene wings athwart the noon, . . .
And, hooting at the glorious sun in heaven,
Cries out, “where is it?”

(79–83)
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■ MODEL ESSAY PAGE – CORRECTLY STYLED: this page MHRA
Like many liberals in England, Wordsworth was deeply moved by the French Revolution
of 1789, seeing it at welcome sign of greater political freedom to come. One critic notes
‘the swiftness with which Coleridge had developed from distracted undergraduate early in
1794 to take a prominent and active role in contemporary radical affairs’.4 Wordsworth’s
viewpoint is well summarized in a letter sent to his friend Matthews in June 1794:

I disapprove of monarchical and aristocratical governments, however, modified.
Hereditary distinctions and privileged orders of every species I think must necessarily
counteract the progress of human improvement.5

Wordsworth, like Coleridge, wanted a large increase in the number able to vote in
elections, very few at this time. As he wrote in ‘A Letter to the Bishop of Llandaff’: ‘If
there is a single man in Great Britain, who has no suffrage [vote] in the election of a
representative . . . he is a helot [slave] in that society’.6 One of Coleridge’s most obviously
political poems, which I will discuss in the next few pages of this essay, is ‘Fears in
Solitude’, where he makes clear how his religious faith lies at the centre of his radical
politics. He deplores atheism, which he compares to an owl ignoring the sun (i.e. God):

(Portentous sight) the owlet, ATHEISM,
Sailing on obscene wings athwart the noon, . . .
And, hooting at the glorious sun in heaven,
Cries out, “where is it?”

4

(79–83)

Nicholas Roe, Wordsworth and Coleridge: The Radical Years (Oxford: Oxford University Press, 1988), p.
117.
5
Roe, p. 157.
6
William Wordsworth, William Wordsworth: Selected Prose (London: Penguin, 1988), p. 156.
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Like many liberals in England, Wordsworth was deeply moved by the French Revolution
of 1789, seeing it at welcome sign of greater political freedom to come. One critic notes
‘the swiftness with which Coleridge had developed from distracted undergraduate early in
1794 to take a prominent and active role in contemporary radical affairs’.7 Wordsworth’s
viewpoint is well summarized in a letter sent to his friend Matthews in June 1794:

I disapprove of monarchical and aristocratical governments, however, modified.
Hereditary distinctions and privileged orders of every species I think must necessarily
counteract the progress of human improvement.8

Wordsworth, like Coleridge, wanted a large increase in the number able to vote in
elections, very few at this time. As he wrote in ‘A Letter to the Bishop of Llandaff’: ‘If
there is a single man in Great Britain, who has no suffrage [vote] in the election of a
representative . . . he is a helot [slave] in that society’.9 One of Coleridge’s most obviously
political poems, which I will discuss in the next few pages of this essay, is ‘Fears in
Solitude’, where he makes clear how his religious faith lies at the centre of his radical
politics. He deplores atheism, which he compares to an owl ignoring the sun (i.e. God):

(Portentous sight) the owlet, ATHEISM,
Sailing on obscene wings athwart the noon, . . .
And, hooting at the glorious sun in heaven,
Cries out, “where is it?”

7

(79–83)

Nicholas Roe, Wordsworth and Coleridge: The Radical Years (Oxford, 1988), 117.
Roe, 157.
9
William Wordsworth, William Wordsworth: Selected Prose (London, 1988), 156.
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